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Generative Sheet Metal Design



About this course



Student Notes:



Objectives of the course Upon completion of this course you will be able to use the enhanced functionalities in the Generative Sheetmetal Design Workbench for the V5R19 release.



Targeted audience Mechanical Designers



Prerequisites
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Students attending this course must have knowledge of CATIA Generative Sheetmetal Design V5R18.
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Generative Sheet Metal Design Student Notes:
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Handling Parts in a Multi-Document Environment How to Use ‘As Result All Views’ Option How to Use ‘As Result With Link All Views’ Option Do it Yourself
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Generative Sheet Metal Design



What’s New in V5R19?



Student Notes:



The list of enhanced functions in CATIA Generative Sheetmetal Design V5R19 is given below: Enhancements in Extrusion: You can now avoid the degeneration of a curve. An error message will be displayed while creating an extrusion with the Automatic Bend option. Also you will see the enhancements to Explode Mode for the following cases: When the extrusion connects with the sheetmetal part When the extrusion does not connect with the sheet metal part Creation of constraints Generation of Sketches Enhancements in Recognize: You can now recognize stamps created on bends and forcibly recognize features other than stiffening ribs and curve stamps. Integration of Unfolded Curve in Drawing: Using the Unfolded View function from the Drafting workbench you can now generate the characteristic axis of a stamp in a drawing.
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Copy / Paste Enhancement: You can now duplicate the sheetmetal part and represent the technological data on this part through drawings.
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Generative Sheet Metal Design



Extrusion Enhancements



Student Notes:
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You will learn how to use the Extrusion enhanced functionalities.
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Generative Sheet Metal Design Student Notes:



Automatic Bend Enhancement (1/2) The following enhancement has been done in the Automatic Bend option of the Extrusion function: If there is a degeneration of curve element for extrusion profile, an error is displayed. (1/2) Extrusion sketch at extreme position: Degeneration of the curve element occurs if the radius of the curve element is less than or equal to the sheetmetal thickness and the Extrusion direction is towards center of the curve element.



The highlighted corner in the sketch has the radius equal to the thickness which is defined in the Sheet Metal Parameter.
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Sketch at extreme position
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Generative Sheet Metal Design Student Notes:



Automatic Bend Enhancement (2/2) If there is a degeneration of curve element for extrusion profile, an error is displayed. (2/2) If Extrusion sketch is at the middle position, degeneration of curve element occurs if radius of curve element is less than or equal to half of the sheet metal thickness.



The highlighted corner in the sketch has the radius equal to half of the thickness which is defined in the Sheet Metal Parameter.
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Sketch at middle position
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Generative Sheet Metal Design



Explode Mode Enhancements



Student Notes:



There are four enhancements in the Explode mode option of the Extrusion function which are as follows: Connected Extrusion’s Explode: The result will depend upon the type of sketch element which is connected to the part. If the connected part is: A line – the result will be a Tangent Wall on Edge. A curve – the result will be a Sub-Extrusion. A line followed by sharp vertex (or circular curve and line) – the result will be a Wall on Edge with Bend. A circular curve followed by line and the extrusion is created with limit types as dimension – the result will be a Wall on Edge with Bend. A circular curve followed by line and extrusion and is created with limit types as ‘up to plane’ / ‘up to surface’ – the result will be a Sub-Extrusion. Disconnected Extrusion’s Explode: The result will depend upon the fixed geometry. If it is located at the profile extremity and on the:
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Line – the result will be a Wall. Curve – the result will be a Sub-Extrusion. Constraints creation during Explode Sketches generated during Explode
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Generative Sheet Metal Design Student Notes:



How to Explode Connected Extrusion (1/5) 1.



Create a fullyconstrained sketch with the first element as a line and the second element as a spline.
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1a



If the connected sketch element is a line, the result will be a Tangent Wall on Edge.
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1b



Create an Extrusion of the sketch using the Exploded mode option.



1c



The result is as shown.



The first sketch element creates a Tangent Wall on Edge. The second sketch element creates an Extrusion.
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Generative Sheet Metal Design Student Notes:



How to Explode Connected Extrusion (2/5) If the connected sketch element is a curve, the result will be a sub-extrusion.



2a



Create a fully constraint sketch with the first element as a curve (spline) and the second element as a line.



Copyright DASSAULT SYSTEMES



2.
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2b Create an Extrusion of the



sketch using the Exploded mode option.



2c The result is as shown.



The first sketch element (spline) creates a sub-extrusion (Extrusion.2) The second sketch element (line) creates an Tangent Wall on Edge.
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Generative Sheet Metal Design Student Notes:



How to Explode Connected Extrusion (3/5) 3.



If the connected sketch element is a line followed by sharp vertex (or circular curve) and line, the result will be a Wall on Edge with Bend.



3a Create a fully-constrained sketch
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with the first element as a line followed by a sharp vertex and then another line.
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3b Create an Extrusion of



the sketch using the Exploded mode option.



3c The result is as shown.



Two ‘Wall on Edge with Bend’ are added in the Specification tree.
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Generative Sheet Metal Design Student Notes:



How to Explode Connected Extrusion (4/5) 4.



If the connected sketch element is a circular curve followed by line, the result of the extrusion with the limit type as ‘dimension’ will be a Wall On Edge with Bend.



4a Create a fully-constrained sketch
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with the first element as a circular curve and then second element as a line.
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4b Create an Extrusion of the



sketch using the Exploded mode option.



4c



The result is as shown.



The ‘Wall on Edge with Bend’ has been added in the Specification tree.
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Generative Sheet Metal Design Student Notes:



How to Explode Connected Extrusion (5/5) 5.
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5a



If the connected sketch element is a circular curve followed by line, the result of the extrusion with the limit type as ‘Up to plane’ / ‘Up to surface'will be a sub-extrusion. Create a fully-constrained sketch with the first element as a circular curve and then second element as a line.



5b Create an Extrusion of the



sketch using the Exploded mode option with the limit as the provided surface.



If the sketch created for Wall on Edge contains a curved edge (i.e. explode of extrusion with limit as Up to surface), it will be under-constrained. In such a case a warning message is displayed.
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5c The result is as shown.



The ‘Sub-Extrusion’ (Extrusion.2) and ‘Tangent Wall on Edge’ are added in the Specification tree.
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Generative Sheet Metal Design Student Notes:



How to Explode Disconnected Extrusion (1/2) 1.



1a



In the cases where the extrusion is not connected to the sheetmetal, if the fixed geometry is at profile extremity and on the line, the result will be a wall. Create a fully-constrained sketch with the elements of the sketch as a line and a curve (spline).



Create an extrusion of the



1b sketch using the Exploded



1c



The result is as shown.



mode option and selecting the extremity of the line as the ‘Fixed geometry’.
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A ‘Wall’ is created along with other features as shown in the specification tree.



Copyright DASSAULT SYSTEMES



Curve Fixed Geometry (Point)



Line This warning lets you know that the extrusion is disconnected.
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Generative Sheet Metal Design Student Notes:



How to Explode Disconnected Extrusion (2/2) 2.



Create a fully-constrained sketch with the elements of the sketch as a line and a curve (spline).
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2a



In the cases where the extrusion is not connected to the sheetmetal, if the fixed geometry is at profile extremity and on the curve, the result is a sub-extrusion.
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Create an extrusion of the



2b sketch using the Exploded



mode option and selecting the extremity of the curve as the ‘Fixed geometry’.



Curve Line



2c



When such a sketch is extruded, then a ‘Sub-Extrusion’ (Extrusion.3) is created along with other features as shown in the specification tree.



Fixed Geometry (Point)



This warning lets you know that the extrusion is disconnected.



16



Generative Sheet Metal Design Student Notes:



Constraints Creation during Explode Points to be aware of when creating an extrusion using Explode: 1



Sketches generated for walls and subextrusions are under-constrained.



2



Sketches generated for the Wall On Edge are fully-constrained.



3



If the sketch created for Wall On Edge contains a curved edge (i.e. explode of extrusion with limit as up to surface), it will be under-constrained. In such cases, a warning is displayed.



4



One plane and additional constraints in ‘Wall on Edge’ sketch are created.



3
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By expanding this ‘Wall on Edge with Bend’, you can see the constraints added to the sketch.
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Generative Sheet Metal Design Student Notes:



Sketches Generated during Explode (1/2) The position of the generated sketches depends upon the selected options. For example: Explode of extrusion created with the extreme position option. All the generated sketches are located at the extrusion profile.



Original Sketch Sketch at extreme position
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Generated Sketches
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Generative Sheet Metal Design Student Notes:



Sketches Generated during Explode (2/2) Explode of extrusion created with the middle position option. ‘Wall’ and ‘Wall on Edge’ sketches are located at either side of the extrusion profile with an offset, equivalent to the half of the sheetmetal’s thickness. Sub-extrusion profiles are located at the extrusion profile.



Original Sketch



Sketch at extreme position
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Generated Sketches



Copyright DASSAULT SYSTEMES



19



Generative Sheet Metal Design Student Notes:



Do It Yourself Curve



Open the Mounting_Bracket.CATPart Create an Extrusion using the Exploded mode option. Create a sketch with a curve as the first element and a line tangent to the curve as the second element (as shown).



Line



Extrude the sketch with the ‘Mirrored extent’ option selected and explode the extrusion using the ‘Explode mode’ option.
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The Specification tree of the end result must contain the ‘Sub-Extrusion’ and ‘Tangent Wall on Edge’.
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Open the Mounting_Bracket_End.CATPart to check the result.
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Generative Sheet Metal Design



Recognize Enhancement



Student Notes:
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You will learn how to use the Recognize enhanced functionalities.
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Generative Sheet Metal Design Student Notes:



Recognition of Stamps on Bends The following enhancement has been done in the Recognize function: Stamps on Bends: The aim of this enhancement is to suppress the limitation that forces the recognized stamps to have a single and planar support. The only multi-support stamps which will be recognized are those which are impacting one or several cylindrical bends.
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Forced faces: All stamps are not automatically recognized because of the confusion they can create with a combination of walls and bends. Hence you have to force the faces to be recognized as stamps. Stiffening ribs and curve stamps which are perpendicular to the bend’s axis are natively recognized. If there is a planar face in the stamp which is not a stiffening rib then it must be forcibly recognized. The preview enables you to visualize which faces are recognized.
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Multi-support stamps which will be recognized Support 2 Support 1 Stamps on Bends (automatically recognized)



Stamp feature is not recognized as Stamp. Hence we need to forcibly select these faces.



Faces of the Stamp feature are now forcibly recognized



Stamps on Bends (Forcibly recognized)
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Generative Sheet Metal Design Student Notes:



How to Recognize Stamps on Bends (1/2) 1.



A stamp feature is created on a part.
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1a



Automatically recognized stamps
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1b



Using the ‘Recognize’ function in the Generative Sheetmetal Design workbench, select a face on the part.



Select the part



1c



Click the ‘Display recognized features’ button. This will show you that the Stamp is automatically Recognized.



Stamps are automatically recognized
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Generative Sheet Metal Design Student Notes:
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How to Recognize Stamps on Bends (2/2) 2.



Forcibly recognized stamps



2a



A stamped part is created with tools in the Generative Shape Design Workbench.



2b



Using the ‘Recognize’ function in the Generative Sheetmetal Design workbench, select the part to be recognized and click the Display recognized features button.



2c



Faces of the Stamp feature are now forcibly recognized.



Stamped Feature created in Generative Shape Design workbench.
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Click in the ‘Faces to keep’ field of Recognize Definition dialog box, and carefully select all the 33 faces of the stamp.



Stamp feature is not recognized as Stamp. Hence we need to forcibly select these faces.
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Generative Sheet Metal Design Student Notes:



Do It Yourself Open the ‘Front_Floor_Section.CATPart’. Recognize the part using the Recognize function. Select the planar face on the part. Click the ‘Display recognized feature’ button in the ‘Recognize Definition’ dialog box. A node called ‘Recognize’ appears in the Specification tree.



Bends



Stamps
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Walls



Compare your end result with the ‘Front_Floor_Section_End.CATPart’.
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Generative Sheet Metal Design



Integrate Unfolded Curve in Drawing



Student Notes:
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You will learn how to use the enhancements of the ‘Point or curve mapping’ functionality.
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Generative Sheet Metal Design



Standard Settings



Student Notes:



The following enhancement has been done in the ‘Point or curve mapping’ function: The administrator can modify the settings in Tools > Standards. New nodes have been added to the SheetMetal node in the Standard Definition dialog box.
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V5R19 V5R19
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Generative Sheet Metal Design



Unfolded Curve Enhancement



Student Notes:



The following enhancement has been done in the ‘Point or curve mapping’ function: A combo-box is added in the ‘Point or curve mapping’ dialog box. When creating an Unfolded Curve you can specify if the feature is a construction element or forms part of the sheet metal process. The default is a construction element. The four possibilities are as follows: Construction Element: The unfolded curve is used for intermediary construction and not needed for the laser process or for the drawing. This curve will never appear in the unfolded view of the drawing. Characteristic Element: This curve needs to be dimensioned in the drawing but is not required for the laser process. The curve will appear in the drawing if defined as visible in the Standards. Marking: This curve will appear in the drawing if defined as visible in the Standards. Engraving: This curve will appear in the drawing if defined as visible in the Standards.



Copyright DASSAULT SYSTEMES



Sketch created
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‘Point or Curve Mapping’ icon.
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Generative Sheet Metal Design



How to Integrate an Unfolded Curve in Drawing (1/2)



Student Notes:



You will learn how to integrate the unfolded curve in a drawing. 1



Create two new sketches (i.e. create alphabets ‘K’ and ‘A’) as shown and click the Exit Workbench icon.



2



Click the Point or curve mapping icon.



3



Select the Sketch.7 and select Construction element in the Type field of the Unfold object definition dialog box.



4 5 6



1



Sketch.8



Sketch.7



2



Click OK in the Unfold object definition. Select the Sketch.8 and select Characteristic element in the Type field of the Unfold object definition dialog box.



3



Click OK in the Unfold object definition.



4
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Generative Sheet Metal Design



How to Integrate an Unfolded Curve in Drawing (2/2) 7



Unfold the part using the Fold/Unfold icon.



8



Create a new drawing.



9



Create an unfolded view using the Unfolded View icon in the drawing. Observe that the only that sketch which is defined as Characteristic element has appeared in the Unfolded View of the drawing.



Student Notes:



7



8
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9
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Unfolded Curve has appeared in the Unfolded view of the drawing.
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Generative Sheet Metal Design



Do It Yourself



Student Notes:



Open the ‘Integration_Of_Unfolded_Curve_In_Drawing.CATPart’. Create a sketch as shown. Define the unfolded curve using the ‘Point or curve mapping’ functionality. Define the curve type as ‘Characteristic element’.
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Create a new drawing and create an unfolded view.



Compare your result with ‘Integration_Of_Unfolded_Curve_In_Drawing_End.CATPart’ and ‘Integration_of_Unfolded_Curve_in_Drawing_End.CATDrawing’.
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Generative Sheet Metal Design



Paste Special Enhancement



Student Notes:
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You will learn how to use the enhancements of the Paste Special functionality.
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Generative Sheet Metal Design



Handling Parts in a Multi-Document Environment



Student Notes:



The following enhancements have been done in the Paste Special function: In addition to the existing Paste Special operations you can now perform the following operations: Add Sheetmetal feature on the resulting part Use the pasted part to generate the drawing representation with technological data Use the pasted part for machining with technological data All these new operations are possible because of the new options added in the Paste Special dialog box.
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V5R19 V5R19
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Generative Sheet Metal Design



How to Use ‘As Result All Views’ Option (1/3)



Student Notes:



You will learn how to paste a body in another document using “As Result All Views” option in the Paste Special dialog box. 1



Create a new part.



2



Tile the windows vertically.



3



Copy the part you have downloaded.



4



Paste the part you have copied into the new CATPart using the Paste Special function from the contextual menu.



1



2
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4
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Generative Sheet Metal Design Student Notes:



How to Use ‘As Result All Views’ Option (2/3) 5



Select ‘As Result All Views’ from the Paste Special dialog box.



6



Click OK in the Paste Special dialog box. The part is copied to the new document but the link with the original part is not maintained.



7



Create a threaded hole feature on the copied part and mirror it using the yz plane as the ‘Mirroring plane’.



8



Create a new CATDrawing.



9



Click the ‘Unfolded view’ icon in the drawing.



10



5 6 6



Create a view of the copied part. The view must contain the threaded hole.



7 Threaded Hole yz plane
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9
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Mirrored Threaded Hole



8



10
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Generative Sheet Metal Design Student Notes:



How to Use ‘As Result All Views’ Option (3/3) 11 12 13



Right-click the Unfolded view created in the drawing and select the Properties from the contextual menu. In the ‘View’ tab of the ‘Properties’ dialog box select the ‘Thread’ check box. Click OK in the ‘Properties’ dialog box. Observe the Thread Representation in the Unfolded view of the drawing.



11 12



Thread Representation
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Generative Sheet Metal Design



How to Use ‘As Result With Link All Views’ Option (1/4)



Student Notes:



You will learn the Paste Special option “As Result With Link All Views” by which you can paste a body in another document. 1



Create a new part.



2



Tile the windows vertically.



3



Copy the part that you have downloaded.



4



Paste the part that you have copied into the new CATPart using the Paste Special function from the contextual menu.



2



3
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1
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Generative Sheet Metal Design Student Notes:



How to Use ‘As Result With Link All Views’ Option (2/4) 5



Select ‘As Result With Link All Views’ from the Paste Special dialog box.



6



Click OK in the Paste Special dialog box. The part is copied to the new document and the link with the original part is maintained.



7



Create a threaded hole feature on the parent part and create a mirror of it using yz plane as the Mirroring plane.



8



Update the copied part.



9



Create a new CATDrawing.



10



5 6



7 Click the ‘Unfolded view’ icon in the drawing. 10



9



8
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Generative Sheet Metal Design



How to Use ‘As Result With Link All Views’ Option (3/4) 11



Create a view of the copied part. The view must contain the threaded hole.



12



Right-click the Unfolded view created in the drawing and select the Properties from the contextual menu. In the ‘View’ tab of the ‘Properties’ dialog box select the ‘Thread’ check box.



13 14



Click OK in the ‘Properties’ dialog box.



Student Notes:



11



13
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Generative Sheet Metal Design



How to Use ‘As Result With Link All Views’ Option (4/4) 15



Student Notes:



Observe the Thread Representation in the ‘Unfolded view’ of the drawing.
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15 Thread Representation
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Generative Sheet Metal Design Student Notes:



Do It Yourself (1/2) Open the ‘CATUSMD19_As_Result_All_Views.CATPart’. Copy the CATUSMD19_As_Result_All_Views.CATPart and paste it in a new document using the ‘As Result All Views’ option. Create threaded holes in the copied part as shown. Create an unfolded view of the copied part in a new drawing. This view will give you the technological data.
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Thread (Technological data)



Original Part



Copied Part



Compare your result with ‘CATUSMD19_As_Result_All_Views_End.CATPart’ and ‘CATUSMD19_As_Result_All_Views_End.CATDrawing’.
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Generative Sheet Metal Design Student Notes:



Do It Yourself (2/2) Open the ‘CATUSMD19_As_Result_With_Links_All_Views.CATPart’. Copy the part and paste it in a new document using the ‘As Result With Links All Views’.



Original Part



Create a threaded hole in the original plate (i.e. Plate.CATPart) as shown. Update the copied part and create an unfolded view of it in the drawing. This view will give you the technological data. Copied Part



Thread (Technological data)
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Original Part



Compare your result with ‘CATUSMD19_As_Result_With_Links_All_Views_End.CATPart’ and ‘CATUSMD19_As_Result_With_Links_All_Views_End.CATDrawing’.
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Generative Sheet Metal Design Student Notes:



Summary In this course you have seen the enhancements to the CATIA V5R19 Generative Sheetmetal Design workbench. CATIA Generative Sheetmetal Design Extrusion Enhancements



V5 R19



Recognize Enhancement Integrate Unfolded Curve in Drawing Paste Special Enhancement
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Enhancements in Local Unfolding
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CATIA V5 Surface Design - MAFIADOC.COM 

Lesson 1: Introduction to Generative Shape Design ... 'CATIA V5 for Surfaces' is to teach you how to build basic and advanced ... This course is designed using a process-based approach to training. ... You should view the student manual as a suppleme










 








Aerospace Sheet Metal Design CATIA V5 Training .fr 

Jan 19, 2009 - Design. Assembly Design. â–« General Check options as shown on illustration. Aerospace Sheet Metal. Set options as shown on illustration ...
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